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1 Introduction 

1.1 Overview 
My interest in BBS applications came about accidentally. 

Packet has been used throughout Santa Clara County (CA) for many years.  Packet is considered 
essential to the County Emergency Managers because of its fail-safe nature and its independence 
of the existing infrastructure in the event of a disaster.  While intended to pass California RIMS 
(Regional Information Management System) reports on disaster and activation status, packet has 
demonstrated its usefulness for passing a variety of list-based traffic that would be impractical on 
voice channels. 

This aspect of packet was also considered very attractive to Santa Clara County Department of 
Health Services (DHS), Office of Disaster Medical Services (ODMS).  ODMS’ mission is to 
coordinate preparedness and response to public health threats and disasters.  One of their key 
constituents are the County Hospitals. 

ODMS has been working to put emergency communications in place for their hospitals throughout 
the county.  With voice communications under control and monthly equipment checks held, their 
focus has turned to packet as a means for rolling up status and passing detailed messages. 

1.2 The need for a packet infrastructure  
The Outpost Packet Message Manager program has been adopted by several of the cities 
throughout Santa Clara County as their standard packet-messaging client. 

Outpost is a Windows-based message client that lets you send and receive packet messages with 
almost any Amateur Radio Bulletin Board System (BBS) or TNC personal mail box. 

I designed Outpost for the ARES/RACES packet user community.  The thinking behind it was to 
create an intuitive, easy-to-use program that lets ARES/RACES organizations focus on the 
"message," not the "medium," as they pass packet traffic to and from an Operational Area BBS. 

Outpost has a similar look and feel to other contemporary mail clients.  It features Windows-
driven forms and screens that handle creating, sending, receiving, and storing packet messages on 
your PC.  It also can run automatically where it periodically checks for out-going and in-coming 
messages.  For more information, see http://www.outpostpm.org/. 

Because of an ease of use requirement, ODMS plans to roll Outpost out to its 14 participating 
hospitals.  Unfortunately, the BBS used by the Santa Clara County RACES organization was not 
an option due to the current user load from participating county cities. 

Thus my search for a BBS. 

1.3 BBS Requirements 
The BBS had to meet several requirements to be viable for the County. 

Hardware Configuration 

1. Common hardware.  The computer needs to be Intel-based to ensure some element of 
supportability and commonality with the bulk of the processing platforms available at the 
County and on the market.   

2. Contemporary Operating System.  I’ve worked in the DOS world before.  However, you loose 
the power of the platform particularly if you have more recent hardware.  The O/S needs to be 
Windows 98, 2000, or XP.  Windows NT is excluded because of the administrative overhead 
that it includes. 
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3. TNC.  The county purchased KPC-3+’s for all hospitals as the standard TNC.  This BBS 
implementation needs to support the KPC-3+. 

4. Radio Channels.  All hospitals will come in on a 2 meter port based on committed radio 
purchases.  A multi-band, multi-port configuration is not currently required.   

BBS Configuration 

5. Number of Ports.  The BBS will need to support up to 14 hospitals, with on average 4 
concurrent connections.  My assumption is that random packet usage will generate a sufficient 
distribution of traffic over the time domain thereby permitting a reasonable level of channel 
loading. 

6. Support Tactical calls.  This is an equivalent feature to what we do with voice nets… All 
assigned users have a tactical call sign that can be passed from user to user regardless of the 
owned FCC Call Sign. 

7. Supportability.  The BBS should be stable, documented, and has a known owner (just in case) 

8. Installed Base.  The BBS should be widely in production.  This implies there is a community 
out there that can act as a resource as you are bringing a BBS on line. 

9. Remote support.  Remote sysops will be recruited and given training. 

Interoperability 

10. Outpost.  Given the Hospital’s desire to use Outpost, this seems to be a good idea. 

 

What is not required 

1. Message forwarding.  For the moment, all messages originating on the BBS are assumed to be 
addressed to participating members of the BBS. 

2. Others? 

1.4 The Solution 
The configuration I have adopted to address the above requirements is: 

F6FBB BBS System (www.f6fbb.org) 

Per the website, “FBB is a bulletin board software for amateur packet-radio.  This software is free 
of charges.  It can be copied or installed only for non-commercial use abiding by the laws. 

“This software has been developed to be compiled on different architectures including MS-DOS 
(DosFBB), Windows 16 (WinFBB-16), Windows 32 (WinFBB-32) and Linux on PC hardware 
(LinFBB).  All these versions have almost the same functionalities.  Some differences may happen 
due to the capabilities of the operating and windowing systems.” 

G8BPQ (BPQ) AX25 Networking Package  
(Many sites have it, I found mine at… http://skyscraper.fortunecity.com/digital/3/bpq/) 

Per the BPQCODE.DOC file, “This software allows an IBM PC, or similar machine, equipped 
with suitable communications hardware, to act as a Node in a NET/ROM compatible AX25 
network, and/or to support a multi-user Mailbox [BBS], or other similar applications. 

“The switch section of the code supports up to 16 AX25 ports, and the application interface 
supports up to 64 connections.   



FBB HOW-TO 
 

04/20/2007 7:27 AM   3

1.5 Other software components 
Along with the application components above, you will need the following: 

PKZIP Required for unzipping the BPQ application 

Terminal Emulator Required to verify that the TNC is functional.  Should be able to set and 
reset the TNC in KISS mode.  While Hyperterm is a good choice for a 
general packet program, PACTERM is a good for sending the control codes 
to reset the TNC back to Command mode. 

 

Make sure these applications are available before proceeding.   

1.6 BBS implementation steps 
The following are the steps to implement this BBS configuration. 

1. Set up the BPQ Software 

2. Setup the F6FBB BBS Software 

3. Final PC configuration 

These topics are covered in detail in the following sections. 
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2 Setting up BPQ 

2.1 Introduction 
This instance of BPQ is tailored specifically to the needs of this project’s FBB BBS 
implementation.  There are undoubtedly plenty of other changes that could be made in terms of 
routes, ports, and other general configuration settings, of which this GUIDE will not address.  
However, BPQ does support the hardware and software configuration with which I had to work. 

I am using version 408A as released in the BPQ408A.ZIP file.  By the time you read this, there 
could be another version available, and if there is a compelling reason to upgrade, I’ll do so and 
update this doc.  Until then, I’m operating under the premise… if it works, don’t fix it… and this 
version works very well. 

This Guide is also not intended to replace the existing document that has been developed and 
included with the distribution of the software.  Instead, it is a confirmed procedure to get 
BPQ408A up and running in preparation for moving on to the FBB portion of the project. 

Note:  The BPQ documentation is pretty good and you should have a copy available prior to 
beginning.   

Note:  While getting a BPQ instance up and running is not complex, it does require an 
ATTENDION TO DETAIL to avoid troubleshooting a problem that did not need to happen, 
particularly if your configuration is different from mine. 

Final Note:  I am NOT a BPQ expert.  However, I did read the docs and spent some time getting it 
to work by doing several clean installs.  My conclusion: you do not have to be a BPQ expert to get 
this software up and running. 

2.2 Current configuration 
My activities for this portion of the project were driven by the constraints under which I had to 
operate (PC, O/S, TNC, etc.).  Therefore, if you choose to follow this path AND your environment 
configuration is different, you may need to tweak the procedure to your own specific needs.  
However, having implemented this once (and running through this procedure 3 times to ensure I 
got this doc right), I am confident that the reader should not have a problem getting BPQ on line. 

The requirements for this portion of the project are as follows: 

PC Pentium III, 233 MHz 

Operating System Windows 98 

Serial Ports COM1, COM2 

TNC KPC-3 

TNC Settings Com1, 9600,8,N,1 

2.3 Finding the BPQ Software 
There are several websites that have the BPQ software available for download and, finding them 
are easy. 

1 Create the directory: \Download\BPQ  

2 Run your browser (Netscape, IE, etc.)  

3 Go to your favorite search site (ie: Google) 
and enter into the search field  
“BPQ408A download”.  

This ensures you get exactly the version of 
BPQ used here.  There may be more recent 
versions that work just as well or better… 
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however this version works fine for me. 

4 Once at one of the sites, download the file 
BPQ408a.zip to your computer and save it 
in directory created above. 

 

2.4 Installation 
BPQ does not comes with a typical “setup.exe” program that installs it in the “C:\Program Files” 
directory, do Windows Registry manipulations, or anything else.  Instead, all the files you need to 
implement BPQ are ready for use once they are unzipped. 

5 Create the directory  C:\BPQ What I used; could be anything. 

6 Move the BPQ408A.ZIP file to this 
directory. 

 

7 Unzip the contents into that directory.  

8 Print the following documents and put 
them in a binder. 

You should have them as reference. 

 

PROGS.DOC A description of all the programs that come with this distribution. 

BPQCODE.DOC Overview doc of the application, and general direction on getting 
it up and running. 

BPQCFG.TXT The BPQ configuration file that comes with the application.  You 
will edit this to get BPQ to work in your environment. 

PORTS.DOC The description of the commands founds in the BPQCFG.TXT 
file for how the ports are set up. 

COMMANDS.DOC Explains the commands available within the Node section of the 
G8BPQ Switch. 

2.5 Configure the BPQ Software 
In general, you can use almost all of the defaults for this setup.  However, there were specific 
changes I made to support my requirements. 

DESQVIEW: Set to “0”, not used.  DESQview is from Quarterdeck and 
implements multitasking under MS-DOS. 

Node Call Sign: KN6PE-3 

Node Alias: CUPTNO (short for Cupertino, CA) 

BBS Call Sign: KN6PE-5 MUST BE THE SAME FOR THE FBB SETUP 

BBS Alias: HOSPTL (abbreviation for Hospital) 

IDMSG: Network node (HOSPTL) 

INFOMSG: KN6PE Packet Switch, Cupertino, CA  CM87xv (1st line) 

CTEXT: Welcome to SCC DHS/Hospital Packet Switch in Cupertino 

Port Config See text file below. 

Routes None used, commented out 
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9 Edit the BPQCFG.TXT file to your 
specifications. 

The following is my BPQCFG.TXT file 
currently in production.  I made 10 
changes to this file that are indicated in 
BOLD text. 

 
; For Version 4.08 
; 
; 
; CONFIGURATION FILE FOR G8BPQ SWITCH SOFTWARE 
; 
; The program which converts this text file to binary 
; form is currently very crude - be VERY careful when  
; editing this file! 
; 
; 
; The order of parameters in not important, but they 
; all must be specified - there are no defaults 
; 
; 
; 
HOSTINTERRUPT=127 ; Sets the Interrupt used to access BPQ Host Mode. Will 
    ; normally be 127, but may be changed if this clashes with 
    ; other software. BTRIEVE seems to use 127, so if you are 
    ; using it, try INTERRUPT=126 
 
 
 
; Memory Usage. If EMS=1, the system will attempt to put its 
; data area into EMS Memory. At the moment it makes no attempt  
; to manage sharing of the EMS window, so you must not run any other 
; software using EMS. 
; 
; Setting EMS=1 seems to cause problems with Desqview. I suggest it 
; is only used with non-DV installations. 
; 
; 
EMS=0    ; dont use EMS RAM 
; 
; I seem to have problems with systems not using DESQVIEW - especially 
; NNA BBS's. The DV calls SHOULD be ignored if DV is not loaded, but 
; just in case, if you set DESQVIEW=0, the 'Release Timeslice' call 
; wont be used. MAKE SURE that you set DESQVIEW=1 if using DV, or 
; performance will be seriously affected. 
; 
DESQVIEW=0 
; 
; 
; Station Identification. 
; 
; If a user connects to the NODE Callsign or Alias, he is linked 
; to the switch code, and can use normal NetRom/TheNet commands 
; 
; If he connects to the BBS Callsign or Alias he will be connected 
; directly to a BBS port. If none are available, the connect will 
; be rejected. 
; 
; Note that of you are running only a NODE (ie BBS=0), or 
; or just a BBS (NODE=0), then you must still put in two pairs of calls, 
; but they MUST be the SAME. 
; 
; If you are running both, the calls MUST be different 
 
NODECALL=KN6PE-3  ; NODE CALLSIGN 
NODEALIAS=CUPTNO 
 
 
BBSCALL=KN6PE-5    ; BBS CALLSIGN  
BBSALIAS=HOSPTL   ; BBS ALIAS 
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; 
; 'ID' MESSAGE - SENT EVERY IDINTERVAL MINS 
; 
; WILL BE ADDRESSED FROM THE PORT CALLSIGN (IF DEFINED) 
;      ELSE FROM THE NODE CALL 
; 
; The following format allows KA nodes to include your system in 
; their 'Nodes' lists. 
; 
IDMSG: 
Network node (HOSPTL) 
*** 
; 
UNPROTO=MAIL   ; DEFAULT UNPROTO ADDR 
 
; 'I' COMMAND TEXT 
; 
; Note that the bit about needing a port param in connects is only 
; necessary if you are running more that one (radio) port. 
; 
INFOMSG: 
KN6PE Packet Switch, Cupertino, CA. CM87xv 
Commands are basically the same as NET/ROM, but to connect to another 
normal station (not another node), you must specify a port number before 
the callsign. Use PORTS command to list available ports. The BBS command 
connects you to the associated Mailbox. 
*** 
; 
; CTEXT - Normally will only be sent when someone connects to  
; the NODE ALIAS at level 2. If FULL_CTEXT is set to 1, it  
; will be sent to all connectees. Note that this could confuse BBS 
; forwarding connect scripts.  
; 
CTEXT: 
Welcome to SCC DHS/Hospital Packet Switch in Cupertino 
Type ? for list of available commands. 
*** 
 
FULL_CTEXT=0   ; SEND CTEXT ONLY TO L2 CONNECTEES TO ALIAS 
 
; Network System Parameters 
; 
OBSINIT=5   ; INITIAL OBSOLESCENCE VALUE 
OBSMIN=4   ; MINIMUM TO BROADCAST 
NODESINTERVAL=60  ; 'NODES' INTERVAL IN MINS 
IDINTERVAL=15   ; 'ID' BROADCAST INTERVAL (UK Regs require 
    ; an AX25 ID every 15 mins) 
; 
BTINTERVAL=0   ; NO BEACONS 
 
L3TIMETOLIVE=25   ; MAX L3 HOPS 
L4RETRIES=3   ; LEVEL 4 RETRY COUNT 
; 
; I have seen suggestions that L4TIMEOUT should be increased to very 
; high values (even as long as seven mins). Although 60 may be a bit  
;  short in some cases, I STRONGLY advise that you dont go much above 
; 120 secs unless you understand ALL the implications. 
; 
; I've set TTL and TIMEOUT to the values agreed by the latest SYSOPS 
; meeting - this does not imply that I agree with them! 
; 
L4TIMEOUT=120   ; LEVEL 4 TIMEOUT 
L4DELAY=10   ; LEVEL 4 DELAYED ACK TIMER 
L4WINDOW=4   ; DEFAULT LEVEL 4 WINDOW 
; 
MAXLINKS=30   ; MAX LEVEL 2 LINKS (UP,DOWN AND INTERNODE) 
MAXNODES=120   ; MAX NODES IN SYSTEM 
MAXROUTES=35   ; MAX ADJACENT NODES 
MAXCIRCUITS=64   ; NUMBER OF L4 CIRCUITS 
MINQUAL=10   ; MINIMUM QUALITY TO ADD TO NODES TABLE  
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BBSQUAL=30   ; BBS Quality relative to NODE - used to 
    ; limit 'spread' of BBS through the network 
    ; to your required service area. I've been 
    ; asked to set a low default to encourage you 
    ; to think about a suitable value. Max is 255 
 
BUFFERS=255   ; PACKET BUFFERS - 255 MEANS ALLOCATE AS MANY 
    ; AS POSSIBLE - NORMALLY ABOUT 130, DEPENDING 
    ; ON OTHER TABLE SIZES 
; 
; TNC DEFAULT PARAMS 
; 
PACLEN=120   ; MAX PACKET SIZE 
; 
; PACLEN is a problem! The ideal size depends on the link(s) over 
; which a packet will be sent. For a session involving another node, 
; we have no idea what is at the far end. Ideally each node should have 
; the capability to combine and then refragment messages to suit each 
; link segment - maybe when there are more of my nodes about than 'real' 
; ones, i'll do it. When the node is accessed directly, things are a 
; bit easier, as we know at least something about the link. So, from 
; Version 3.11 onwards, there are two PACLEN params, one here and 
; one in the PORTS section. This one is used to set the initial value 
; for sessions via other nodes, and for sessions initiated from here. 
; The other is used for incoming direct (Level 2) sessions. In all cases 
; the TNC PACLEN command can be used to override the defaults. 
; 
; The main reason for changing this now was a request from someone 
; wanting to run an HF port. 
; 
; 
; 
TRANSDELAY=1   ; TRANSPARENT MODE SEND DELAY - 1 SEC 
; 
; Level 2 Parameters 
; 
; T1, T2 and N2 are now int the PORTS section 
; 
T3=180    ; LINK VALIDATION TIMER (3 MINS) 
 
IDLETIME=900     ; IDLE LINK SHUTDOWN TIMER (15 MINS)  
; 
; 
; Configuration Options 
; 
BBS=1    ; INCLUDE BBS SUPPORT 
NODE=1    ; INCLUDE SWITCH SUPPORT 
; 
HIDENODES=0   ; IF SET TO 1, NODES STARTING WITH # WILL  
    ; ONLY BE DISPLAYED BY A NODES * COMMAND 
; 
; THE *** LINKED COMMAND IS INTENDED FOR USE BY GATEWAY SOFTWARE, AND 
; CONCERN HAS BEEN EXPRESSED THAT IT COULD BE MISUSED. I RECOMMEND THAT 
; IT IS DISABLED IF NOT NEEDED. 
; 
ENABLE_LINKED=N  ; CONTROLS PROCESSING OF *** LINKED COMMAND 
    ; Y ALLOWS UNRESTRICTED USE 
    ; A ALLOWS USE BY APPLICATION PROGRAM 
    ; N (OR ANY OTHER VALUE) DISABLE 
; 
; 
; 
; 
; 'COMBIOS' Port definitions. 
; 
; This section defines the virtual TNC's that the code supports. 
; 
; The basic format is: 
; 
;     TNCPORT 
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;  COM=n  ; COMBIOS port number 
;  APPLMASK=nn ; Defaults to 1 (BBS) 
;         APPLFLAGS=nn ; Defaults to 6  
;      ENDPORT 
; 
; See APPLS.DOC for details on use of APPLFLAGS and APPLMASK 
;  
; Only TNC2 applications are supported through this interface. 
; For information on using KISS or DEDHOST applications, see file 
; DRIVERS.DOC 
; 
;   Dont try to define more than 16 ports. 
;  
TNCPORT 
 COM=1 
ENDPORT 
 
 
TNCPORT 
 COM=3 
 APPLFLAGS=4  ; NO 'CONNECTED' TO USERS 
ENDPORT 
 
 
; 
; AX25 PORT DEFINITIONS 
; 
; These define the external links - normally to radios, but possibly 
; to other computers, modems, etc. 
;  
; The hardware type and protocol are now defined separately, but 
; at the moment only a limited number of combinations are possible 
; 
; Interrupt levels may be shared by any cards with suitable 
; hardware. Examples are all but the earliest DRSI cards, and 
; a MS400 modified as described by AA4RE in his MBBIOS documentation. 
; 
; There is a significant overhead in using the shared interrupt 
; feature - try to use it on relatively low speed links, and 
; wath out for TX underruns/RX overuns. 
; 
; 
; See file PORTS.DOC for full details of available paramters. 
; 
;  Note that all timer values are in ms intervals. Most TNC's 
; use different units for the various timers, so be careful! 
; 
; The timings are all derived from the PC's timer interrupt, 
; who's frequency is about 18.2 HZ, so the resolution is only to  
; approx 50ms. 
; 
 
PORT 
 ID=144.950 SCC/DHS Port 
 TYPE=ASYNC 
 PROTOCOL=KISS 
 IOADDR=3F8H 
 INTLEVEL=4 
 SPEED=9600 
 CHANNEL=A 
 QUALITY=10 
 MAXFRAME=2 
 TXDELAY=500 
 SLOTTIME=100 
 PERSIST=64 
 FULLDUP=0 
 FRACK=7000 
 RESPTIME=2000 
 RETRIES=10 
 PACLEN=120 
ENDPORT 
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ROUTES: 
; 
; ROUTES TO LOCK IN 
; 
; specify Callsign, Quality and Port. You can now also specify 
; MAXFRAME, FRACK, PACLEN (in that order) to override the port 
; defaults. 
; 
; G4RFG-1,0,2   ; MARGINAL, SO QUALITY = 0 
; G4RFG,0,1 
; GB7LX-2,0,1 
; GB7LX-7,20,2 
; G0GDR-1,100,2,1,6000,100 ; not always very good, so maxframe=1 
*** 
; 
; APPLICATIONS SUPPORTED 
; 
; UP TO 8 ENTRIES OF UP TO 12 BYTES EACH 
; 
; THE FIRST 3 ARE RESERVED FOR BBS, HOST, AND REMOTE SYSOP - YOU 
; CAN DEFINE THE OTHERS AS YOU LIKE. 
; 
; FOR COMPATIBILITY WITH EARLIER VERSIONS, JUST ENTER APPLICATIONS=BBS 
; 
; NAMES STARTING WITH * ARE NOT INCLUDED IN 'VALID COMMANDS' DISPLA 
; 
APPLICATIONS=BBS,,*SYS,CHAT/C NMCHAT 
; 
; NOTE THAT THE LAST ITEM CREATES A 'COMMAND ALIAS'. IF THE USER 
; ENTERS 'CHAT' THIS IS CONVERTED BY THE SWITCH TO 'C NMCHAT'. THE 
; TOTAL LENGTH OF THE PAIR CANNOT EXCEED 15 BYTES 
; 

10 When done, save the file.  

11 Run the BPQCFG.EXE program by double-
clicking the program name. 

This program converts the configuration file 
BPQCFG.TXT into a binary file 
(BPQCFG.BIN) that is accessed by the 
BPQCODE.EXE program.   

VERIFY that the program reports…  
“Conversion (probably) successful” 

NOTE: any subsequent changes to the 
BPQCFG.TXT will require this program to 
be run again, BPQCODE.EXE to be 
stopped, then re-started for the changes to 
take affect. 

2.6 Setting up the KPC-3 
12 Using any terminal emulator program, 

confirm the KPC-3 is working correctly in 
Host Mode. 

I used Hyperterm.  Make sure you can get 
to the command prompt. 

13 Put the TNC is KISS mode. At the TNC 
cmd prompt, enter the following 
commands: 

cmd:  Int kiss 
cmd:  reset 

 

Exit the terminal emulator program. 

After typing reset, you won’t get any other 
response from the TNC.  At this point, the 
TNC is in KISS mode.   
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2.7 Initial BPQ Configuration Test 
To test that the BPQ configuration is correct, do the following: 

14 Turn on your radio and TNC.  Set the 
frequency to your packet channel. 

An obvious step, but how many of you 
actually tried to operate packet without 
doing this? 

15 Make sure you are in the BPQ directory  
(cd  \BPQ) 

For the test, when you run the BPQ 
program, you need to be in the same 
directory as the BPQCFG.BIN file. 

16 Run the BPQCODE program. A DOS window is opened and a message is 
displayed stating that the program is started.  
DO NOT close this window.  Closing the 
window will end the BPQCODE program. 

17 Verify you can connect to the BPQ port. 

From this 2nd PC, enter the following 
command to connect to the node 
cmd:  connect kn6pe-3 

 

This requires a 2nd PC with packet 
capabilities and a Terminal Emulator 
program.  Make sure that PC’s TNC is 
working correctly. 

A connect message is displayed and you 
should be connected to the BPQ Node. 

18 Test some basic NODE commands.  From 
this 2nd PC, enter the following commands: 
? Causes the Node commands to be  
 displayed 
INFO Displays the “INFOMSG”  
 message 
PORTS Displays the single port we  
 configured 

If you get this far, this confirms that the 
BPQ is running and the config file was 
probably set up correctly. 

19 Stop the BPQCODE Program. This is done in the DOS window.  Close the 
window to make sure it is off. 

2.8 Final System Configuration 
20 At the BPQ node computer edit the 

AUTOEXEC.BAT file, and add the 
following lines. 
CD \BPQ 
BPQCODE 

 

The BPQCODE must ultimately be loaded 
as a system program, not a user’s session 
program.  FBB will be looking for it as a 
system program.  This is done by adding 
these lines to the AUTOEXEC.BAT.  Then, 
at boot up, before the rest of Windows is 
loaded, the BPQCODE program is run. 

NOTE: this file may be hidden.  To unhide 
all files: Start> Settings> Control Panel> 
Folder Options> View.  Click on “show 
hidden files and folders”… press OK 

21 Copy the following files from the C:\BPQ 
directory to the C:\Windows\Systems 
directory. 

BPQCODE.386 
BPQDLL.DLL 

These are required for BPQCODE to run as 
a system program.  If you skip this step, 
BPQCODE will error out when it is run. 

NOTE: this file may be hidden.  To unhide 
all files: Start> Settings> Control Panel> 
Folder Options> View.  Click on “show 
hidden files and folders”… press OK 
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22 Reboot the BPQ node computer. After the initial Windows 98 banner, the 
screen will go BLACK and display one line 
at the top of the monitor stating the 
BPQCODE is started.  Windows will 
continue to boot as usual.  BPQCODE is 
now loaded as a system program. 

23 Verify you can connect to the BPQ port.  
Enter the following command: 

cmd:  connect kn6pe-3 

Try entering some of the commands 
previously tried. 

From another PC with packet capabilities, 
run a Terminal Emulator program.   

A connect message is displayed and you 
should be connected to the BPQ Node. 

 

24 If you get this far, you are ready for the 
FBB portion of the setup. 
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3 Setting up FBB 

3.1 Introduction 
Configuring the FBB software can include several different kinds of options to support a variety of 
needs. 

This instance of FBB has the following requirements: 

1.  Support 14 hospitals.  Additional medical centers may be added later. 

2.  Allow up to 8 simultaneous connections. 

3. No networking to other BBSs. 

3.2 Before you begin  
Before beginning, print the following documents and put them in a binder.  You should have them 
for reference. 

First Doc www.f6fbb.org/fbbdoc/docfirst.htm, For SysOps who have never 
used FBB software before. 

SysOp Commands www.f6fbb.org/fbbdoc/docsysop.htm, Describes the SysOp 
commands available under the BBS menu. 

Console Commands www.f6fbb.org/fbbdoc/docfunck.htm, Describes the console 
commands. 

BBS commands www.f6fbb.org/fbbdoc/docbbs.htm, Overview of the BBS 
commands. 

INIT.SRV www.f6fbb.org/fbbdoc/fmtinit.htm, The file that FBB looks for 
when starting up. 

INIT.PORT.SYS www.f6fbb.org/fbbdoc/fmtport.htm, The file that FBB looks for 
on port information. 

BPQ config info www.f6fbb.org/fbbdoc/fbpq.htm, The file that describes how 
BPQ is configured into the system. 

 

Unlike BPQ, the FBB configuration is more extensive with both interactive (forms based) and 
manual (you edit a config file) configuration setups.  All configurations will end up in one of 
several configuration files.  Some of these files are (assumes the default C:\FBB installation 
directory is selected at install time): 

Configuration Files that you must check or change 

These files should be changed either programmatically or manually.   

Config File Location Updated By Description 

init.srv c:\fbb\. Instwfbb.exe Contains most of the FBB settings.  

port.sys c:\fbb\system\ Instwfbb.exe Contains a variety of information on the 
TNCs, the number of channels, and other I/O 
related configuration. 

inittnc1.sys c:\fbb\system\ Manually Contains startup parameters for TNCs 

maint1.sys c:\fbb\system\ Manually Contains shut-down parameters for TNCs 
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Config File Location Updated By Description 

bbs.sys c:\fbb\system\ Manually Defines all BBSs that receive bulletins.  All 
entries are removed for this instance. 

forward.sys c:\fbb\system\ Manually Contains information for how to forward 
messages.   

passwd.sys c:\fbb\system\ Manually Password file for remote SYSOPs. 

 
Configuration Files that you could change 

These files may require some changes if your situation requires it.  I made no changes to these 
files. 

beacon1.sys c:\fbb\system\ Manually Configures the Beacon Text 

cron.sys c:\fbb\system\ Manually Defines which tasks or programs are run 
every hour. 

gateway.sys c:\fbb\system\ Manually  

langue.sys c:\fbb\system\ Manually Defines which languages are useable by the 
BBS. 

memo.sys c:\fbb\system\ Manually  

multi.txt c:\fbb\system\ Manually  

protect.sys c:\fbb\system\ Manually Defines “safe” directories 

redist.sys c:\fbb\system\ Manually Defines bulletin redistribution. 

reject.sys c:\fbb\system\ Manually  

swapp.sys c:\fbb\system\ Manually Swap to/from/etc in messages (?) 

themes.sys c:\fbb\system\ Manually Defines various theme zones 

 

Executable Files 

Along with the Configuration files, these are the key executable files that you will encounter. 

Exe File Location Description 

Runfbb.exe c:\fbb\bin The FBB program.  

Runfbb.bat c:\fbb\bin This is the very first file that Runfbb invokes.  Per the 
documentation, “you really do not have to make any changes in 
the file, unless you did some changes during the installation 
process.  … path names may be the extent of the changes 
required.” 

Instwfbb.exe c:\fbb\bin A forms-based program that collects information and writes it 
to the INIT.SRV and PORT.SYS files.  Eighteen menus are 
accessed sequentially where you can enter configuration data.  
While most of the forms are very intuitive, the final few BBS 
port setup forms, in my opinion, were not. 

This program is called during the Installation process as well as 
selectable from the FBB BBS application form the FBB “Main 
Parameters” menu. 
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3.3 Finding the FBB Software 
The best reference for the FBB BBS software is the source… www.f6fbb.org.  There are several 
websites that have the BPQ software available for download and, finding them are easy. 

 Create the directory: \Download\FBB  

1 Run your browser (Netscape, IE, etc.)  

2 Proceed to www.f6fbb.org.   This is the author’s site for the FBB BBS 
software. 

3 On the left, find and click on  
“Latest Versions” 

 

4. In the WinFBB category, download the 4 
files to the directory created above: 
WinFBB 7.00g Disk 1 (w700g-1.zip) 
WinFBB 7.00g Disk 2 (w700g-2.zip) 
WinFBB 7.00g Disk 3 (w700g-3.zip) 
WinFBB 7.00i Upgrade to 7.00i  
   (w700g-1.zip) 

 

3.4 Installation 
FBB comes with a Windows setup program that manages the entire setup process.   

1 Unzip the contents of the following 3 files 
into the directory where the zip files are 
located. 
w700g-1.zip 
w700g-2.zip 
w700g-3.zip 

 

3 Run the INSTALL.EXE file. This runs the install process. 

4 When prompted, accept the default install 
directory for FBB (C:\FBB). 

If you want WinFBB installed elsewhere, 
change it now by entering a new drive/path, 
but be prepared to edit any file that had 
c:\FBB as the default. 

5 When prompted, read and close the readme 
file. 

 

6 Accept changes to the SYSTEM.INI file. This step adds the following line to support 
TNC’s: 
comm.drv=fbbcomm.drv 

7 Accept changes to the AUTOEXEC.BAT 
file. 

This adds 2 KB to the environment. 

8 Configure the FBB software (described 
below). 

As one of the last steps of the installation 
process, the FBB configuration program 
(INSTWFBB) is run.   The following 
section covers this program. 

 



FBB HOW-TO 
 

04/20/2007 7:27 AM   16

3.5 Main FBB Software Configuration 
The INSTALL.EXE program runs the INSTWFBB program.  This program presents a sequence of 
forms that collect information about the FBB instance. 

The following 18 tables describe the changes (in BOLD) to each form that I made to get my 
instance of FBB up and running the way I wanted.  Final configuration edits can be made directly 
to the INIT.SRV and PORT.SYS files using any editor that can create and save ASCII files, of 
from the INSTWFBB program from one of FBBs’ menu options. 

1. BBS Information 

This is the first form displayed during the Configuration process.  The information from this form 
is written to the C:\Fbb\init.srv file. 

Field Value Comments 

BBS Call Sign: KN6PE This is the call sign to which users will connect.  
Must match the call sign used by BPQ. 

SSID: 5 Must match the SSID used by BPQ. 

H Route: #NCA.CA.USA.NOAM The hierarchical address to this BBS.  This will 
be critical to get right in the event Forwarding 
is later enabled.  Enter your Route. 

City: Cupertino The city where the BBS operates.  This text 
shows up as part of the BBS Beacon message. 

Qth Locator: CM87xv The maidenhead grid identifier for this BBS. 

Zip Code: 95014 The zip code of where this BBS is located. 

Msg Header [$c] FBB$E $$:$R Default value. 

 

2.  Directories and Special Files  

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

System Files: C:\FBB\SYSTEM\ Default value 

Messages: C:\FBB\MAIL Default value 

Bin Messages: C:\FBB\BINMAIL Default value 

YAPP: C:\FBB\USERS\YAPP Default Value 

Documentation: C:\FBB\DOCS Default Value 

Import file: C:\FBB\MAIL.IN Default value 

BBS-Up File: <blank>  

BBS-down File: <blank>  

 

3.  FbbDos Virtual Disks 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

Disc C C:\FBB\USERS Default value.  All other fields left blank. 
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4.  Sysop and UI Information 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

SYSOP’s Call Sign: KN6PE Name of the primary SYSOP 

SysOp First Name: Jim  

SysOp Msgs To: ***** Default value 

WP Msg Via: NO Default value, unchecked 

Back nb in UI: 500 Default value 

Seconds between UI: 5 Default value 

Ack Messages in UI: YES Default value, checked 

Transit Priv mail in UI: YES Default value, checked 

End user priv mail in UI: YES Default value, checked 

Subject displayed in UI NO Default value, unchecked 

 

5.  Default options at first connection 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

Expert YES Checked.  Because all planned users will 
connect with Outpost, we do not need 
superfluous prompts. 

Sysop NO Default value, unchecked 

BBS NO Default value, unchecked 

PMS NO Default value, unchecked 

Paging NO Default value, unchecked 

See All messages NO Uncheck.  Displays the list of messages for a 
station on initial connection.  Outpost will 
prompt for an exact message list anyway.  If 
left checked, this just adds unnecessary channel 
traffic. 

Unproto List NO Uncheck.  Used by other systems listening to 
the UI packets on a frequency to create a list 
identical to the one of the BBS.  If left checked, 
this just adds unnecessary channel traffic. 

List of new messages at 
Logon 

NO Uncheck.  Displays the list of all new messages 
on the BBS since last connection.  Outpost will 
prompt for an exact message list anyway.  If 
left checked, this just adds unnecessary channel 
traffic. 
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6, 7, 8.  Access Security Options 

The next 3 screens are essentially the same, but for different security levels.  The information from 
this form is written to the C:\Fbb\init.srv file. 

Field User SYSOP Security after  
Sysop command 

Comments 

Read all messages Yes Yes Yes Default value 

Kill all messages   Yes Default value 

SYS Command Allowed  Yes Yes Default value 

Remote SysOp commands   Yes Default value 

Edit FbbDos labels  Yes Yes Default value 

Delete FbbDos files  Yes Yes Default value 

Access to all gateways   Yes Default value 

Run DOS Programs   Yes Default value 

Access to the whole disk   Yes Default value 

Special Commands (/A, /R)   Yes Default value 

 

9.  Warning messages 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

<all fields> YES Default Value, checked. 

 

10.  Forwarding 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

<all fields> NO Uncheck these boxes.  FBB comes with the 
first 3 fields -- FBB Forwarding, Compressed 
Forwarding, and Compressed forwarding with 
resume – checked.  Because our 
implementation of FBB will not do any 
forwarding, uncheck all fields.   

 

11.  Miscellaneous 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

Test Mode: NO Uncheck this box.  FBB comes with this 
checked.  Uncheck this box to ensure FBB 
talks to the BPQ ports. 

Full Log YES Default Value, checked 

Indication of Channels: YES Default Value, checked 
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Field Value Comments 

User must give 
information 

NO Uncheck.  Because we know who is logging 
in, there is no reason to prompt for this info.  
If forwarding is enabled in the future and the 
BBS gets more general use, then we may want 
to know who is using the system for audit 
purposes. 

If this BBS becomes heavily networked, then 
this should be changed to YES, and confirm 
that all Hospital users are pre-registered prior 
to an emergency. 

Bulletins in mail beacon: Yes Default value 

<all other fields> <used default> Default value. 

 

12.  Memory Cache 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

<all fields> YES Default values, checked. 

 

13.  Color configuration 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

<all fields> <default values> Default values.  Else, change to suit your 
needs. 

 

14.  Windows Information 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

Buffer of user window 1000 Default value. 

Buffer of console window 1000 Default value. 

Buffer of monitor window 1000 Default value. 
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15.  Time Information 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

Difference with UTC (hrs): -7 Cupertino is 7 hours behind UTC time 
(daylight savings time at the time of this 
writing). 

Time for housekeeping (hrs): 2 Default value. 

Time out user (Min) 10 Default value. 

Time-out during fwd (min): 10 Default value. 

Lifetime for bulletins (days): 30 Default value.  Need to assess based on the 
requirements of the served agency. 

YAPP max download (KB) 100 Default value. 

Modem max download (KB): 0 Default value 

 

16.  Servers 

The information from this form is written to the C:\Fbb\init.srv file. 

Field Value Comments 

<all values> <use defaults> Default values.  

 

17.  Communication Configuration 

The information from this form is written to the c:\Fbb\System\PORT.SYS file. 

Field Interface 
Value 

Comments 

COM1 None Default values.  

COM2 None Default values.  

COM3 None Default values.  

COM4 None Default values.  

COM5 None Default values.  

COM6 None Default values.  

COM7 None Default values.  

COM8 BPQ VXD Default values.  Only COM8 is set for an interface 
type in accordance with how BPQ is set up.  Refer to 
the BPQ documentation for the COM8 description. 

COM9 None Default values.  

COM10 None Default values.  
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18.  Communication Configuration 

The information from this form is written to the  c:\Fbb\System\PORT.SYS file. 

Field Value Comments 

Port: 1 Port selection is on the left.  This form is used to 
set up each port.  Selecting a different port will 
bring up the current configuration for that port.  
For this installation, only PORT 1 is used. 

Host Mode (Interface 
Type): 

BPQ This label is not marked, but includes the 2 left-
most columns of 9 interface choices on bottom of 
the form.  Select this first, since it will enable and 
set up some of the following default fields. 

COM: 8 BPQ operates on Com Port 8 per the BOQ doc. 

BPQ Port: 0 Set to 0 

Nb ch: 8 The number of concurrent users that can connect 
at a time. 

Paclen: 230 Default value when BPQ is selected 

MaxFrame: 4 Default value when BPQ is selected 

Nb Fwd: 1 Default value when BPQ is selected 

Max Blk: 10 Default value when BPQ is selected 

Fwd Min: 30 Default value when BPQ is selected 

Fwd Per: 60 Default value when BPQ is selected 

Info: 144.950 The 2 meter frequency on which this BBS will 
operate.  This is for display only. 

Port Mode: Users Checked.  This is 1 of 3 choices below the Info 
field. 

Services: None Unchecked.  YAPP and GATEWAY are optional 
services that can be handled on this port.  These 
are currently not needed (or completely 
understood) for this setup to work. 

3.6 Completing FBB Software Configuration 
9 When done,  

 press File > Save. 
 press File > Exit 

 

10 Accept all Language files. This is optional, and appears to have no 
impact on the FBB. 

11 Accept the Reboot when prompted. This is required to allow the COM driver to 
take effect. 

3.7 Upgrade to version w7.00i 
12 Unzip the file w700i-1.zip.  

13 Copy the WFBB.EXE file to the 
C:\FBB\BIN directory 

This step replaces the existing w7.00g 
WFBB.EXE file version. 
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3.8 Check the INIT.SRV File 
Additional information is available from  http://www.f6fbb.org/fbbdoc/fmtinit.htm 

If you completed the “Main FBB Software Configuration” step (INSTWFBB.EXE above) 
correctly, no further changes should be needed to this file.  When complete, the C;\FBB\Init.srv 
should look like this.  You should be able to see each change mapped into this file. 

 
# FBB7.00 
# 
########################### 
# INIT.SRV for FBB 7.00   # 
# for KN6PE BBS by KN6PE  #     Manual change 
########################### 
# 
# Set-up file 
# 
# 
# Callsign and H-route of BBS, without SSID 
KN6PE.#NCA.CA.USA.NOAM 
# 
# SSID of BBS 
5 
# 
# Qra Locator of this BBS 
CM87XV 
# 
# Qth of this BBS 
Cupertino, CA 
# 
# Directory of system files 
C:\FBB\SYSTEM\ 
# 
# Directory of message files 
C:\FBB\MAIL\ 
# 
# Directory of compressed files 
C:\FBB\BINMAIL\ 
# 
# Directory of users' DOS. 
# Up to 8 drives (will appear as drive A: to H:) may be specified. 
# These can be physical drives (disks/hard-disks) or direct on C: 
*,*,C:\FBB\USERS\,*,*,*,*,* 
# 
# Directory of YAPP files 
C:\FBB\USERS\YAPP\ 
# 
# Directory of documentation files 
C:\FBB\DOCS\ 
# 
# First name of SYSOP 
Jim 
# 
# Callsign of SYSOP 
KN6PE 
# 
# May have more callsigns, seperated by a space. 
# Callsign (and route if needed) that will have copy of SYSOP messages 
# ***** cancels. 
***** 
# 
# Path and filename for import file 
C:\FBB\MAIL.IN 
# 
# Type of video and time before screenblank 
# Type: 0=CGA, 1=EGA, 2=VGA 
# Screenblank:  Number of no-activity minutes before blanking.  0=disable 
2 60 
# 
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# 
# Full log (OK or NO) 
OK 
# 
# Direct video (OK or NO) 
OK 
# 
# Indication of channels (OK or NO) 
OK 
# 
# Test-Mode (NO - OK) and WinFBB ONLY: watchdog: 1->9 = COM1->COM9 or 
# 81->84 = LPT1->LPT4. 
NO 
# 
# Use (when possible) forward type FBB (OK or NO) 
############################################################################## 
# New in 5.15c45-51: Parametres:  
#  1  : A space is mandatory before the @ in a send message command 
#  2  : The length of the fields of a hierarchical address is not  
#       tested to be 6 characters 
#  4  : The header line of a message is not truncated to the space before 
#       the 79th character 
#  8  : Header MBL/RLI 
#  16 : If there is no BBS field, the callsign of the BBS is sent to the PMS 
#  32 : Deletes the DATA messages sent to SYSOP 
#  64 : Don't use the BID recovered from headers and use a new one 
#  128: Accepts forwarding only from pre-declared BBS 
#  256: WP Messages are not held. 
#  512: XForwarding protocole has priority on FBB protocole. 
# 1024: Generation of an alternate BID like F6FBB-12345 (for dual BBS site) 
# 2048: Checksum unvalidated on XFwd. 
# 4096: Test of callsigns is less strict.  Allows all "callsigns" as long 
#       as they have one figure (0-9) anywhere in the callsign. 
NO 
############################################################################## 
# 
# Use (when possible) compressed forward (OK or NO) 
#  
# Add 1 if forward-resume is allowed (should normally be..) 
############################################################################## 
# New in 5.15c51: 
# Add 2 if XFWD is allowed 
NO 0 
############################################################################## 
# HROUTE look-up and database update validation (OK or NO) 
OK 
# 
#  User must give Name, HomeBBS, Qth and ZipCode (OK or NO) 
OK 
# 
# First connection mask : 
# 0   : Disable 
# 1   : Excluded 
# 2   : Local 
# 4   : Expert 
# 8   : Sysop 
# 16  : BBS 
# 32  : Pagination 
# 64  : Guest 
# 128 : Modem 
# 256 : See-all-messages 
# 512 : Unproto list asking is allowed 
# 1024: List of new messages at logon 
1920 
# 
# 
# Security codes. 
# Users can : 
# 1  : Read all messages, including private messages 
# 2  : Kill all messages 
# 4  : Send SYS command 
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# 8  : Use remote sysop commands (edit, forward, etc...) 
# 16 : Edit labels in YAPP, FBBDOS, DOCS 
# 32 : Can delete files in YAPP, FBBDOS 
# 64 : Have access to all gateways 
# 128: Run DOS commands 
# 256: Have access to the entire hard disk 
# 512: Have access to commands /A (stop) and /R (Reboot) 
# All:   Sysop: Sysop after successful SYS-command: 
0      53     1023 
# 
# New in 5.15b: 
# Warning-messages to sysop: 
#    1: Disk almost full (less than 1 Mb free) 
#    2: Error in system-file (FORWARD, BBS, REJECT..) 
#    4: Server-error 
#    8: Ping-Pong 
#   16: Missing forward-route 
#   32: Missing NTS-route 
#   64: Message not found 
#  128: Error in forward-proposal 
#  256: Message rejected at remote BBS 
#  512: Message is being held at remote BBS 
# 
1023 
# Time (hour) for housekeeping (cleanup of messages) 
2 
# 
# Time-out for normal users and during forward: 
10 10 
# 
# Max download-size (kilobytes) pr period for YAPP and via modem. 
# 00 disable 
100 0 
# 
# Hours +/- in relation to UTC 
-7 
# 
# Number of callsigns in mail beacon.  B means include local bulletins. 
B20 
# 
# Number of lines in scroll buffers 
# 
# User  Console  Monitoring 
1000 1000 1000 
# 
# Text for forward header (Do not change !) 
# 
[$c] FBB$E $$:$R 
# 
# Number of saved BIDs. Max 32000 
# Use as many as possible (depends on memory) 
10000 
# 
# Lifetime for bulletins (days) 
30 
# 
############################################################################ 
# New in 515c7:  OVR removed 
# Use memory-vcache.  No=0, Yes=1 (preferred) 
# In memory-cache: BID MSG HIE SCR WPG REJ FWD 
1 BID MSG HIE SCR WPG REJ FWD 
# 
############################################################################## 
# 
# List of routes to send WP messages 
 
# 
# 
# Zip of this BBS 
95014 
# 
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# Back number, delay, type of messages in unproto lists 
# A = ACK-messages 
# P = Personal messages to local users 
# V = Personal messages in transit 
# M = Subject is replaced with stars in personal mail 
# 
500 5 AVP 
# 
# DRSI and TFPC interrupt (Hexadecimal, default FF and FE) 
FF 
# 
# Programs to start just before BBS starts and shuts down 
# 
# BBS-UP program (default empty) 
 
# 
# BBS-DOWN program (default empty) 
 
# 
# Colour on texts : 
# 
# Black      : 0     Dark grey     : 8 
# Blue       : 1     Light blue    : 9 
# Green      : 2     Light green   : 10 
# Cyan       : 3     Light cyan    : 11 
# Red        : 4     Light red     : 12 
# Magenta    : 5     Light magenta : 13 
# Brown      : 6     Yellow        : 14 
# Light grey : 7     White         : 15 
# 
# 
# Background colors : 
# 
# Status (top) 
1 
# Separation (middle) 
7 
# Texts (bottom) 
0 
# Menues 
4 
# 
# 
# Foreground colors : 
# 
# Status (top) 
7 
# Separation (middle) 
1 
# Menues (bottom) 
14 
# Text sent 
10 
# Text received 
12 
# UI (headers) 
15 
# UI (text) 
7 
# Console 
14 
# Beacon 
6 
# Channel marking 
11 
# 
------- 
# 
# List of servers : 
# Internal servers REQCFG and WP new in 5.15 
# 
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REQDIR  REQDIR.COM     Request directory 
REQFIL  REQFIL.COM     Request file 
REQCFG  **********     Request configuration 
WP      **********     Request White pages info 
MULTI   MULTI          Multi-server, default language (english) 
# 
# End of INIT.SRV file 

# 

3.9 Check the PORT.SYS File 
The following is an excerpt from  www.f6fbb.org/fbbdoc/fmtport.htm. 

If you completed the “Main FBB Software Configuration” step (INSTWFBB.EXE above) 
correctly, no further changes should be needed to this file.  In this file we decide what kind of 
TNCs to use, how many available channels etc.  A line starting with # is a comment-line.  The 
following example has the bulk of the text comments removed.  See the documentation for details 
on all fields. 

 
# FBB7.00 
# File for programming of channels and TNCs. 
# 
#Ports TNCs 
1     1 
# 
#Com Interface Address (device)   Baud 
8    2          0           9600  
# 
#TNC NbCh Com MultCh Pacln Maxfr NbFwd MxBloc M/P-Fwd Mode Freq 
0   0    0   0      0     0     0     0      00/01   ----  File-fwd. 
1   8    8   0      230   4     1     10     30/60   UQ 144.950 
# 
#TNC Nbs Callsign-SSID Mode 
#1    1   LA1B-1        B 
# 
# End of file. 
# 

3.10 Final System Configuration 
14 Edit the AUTOEXEC.BAT file, and add the 

following lines. 
PATH=%PATH%;c:\FBB\BIN 

 

This adds the FBB path to the system 
configuration.  When done, the autoexec.bat 
file should look like this… 
 
  PATH=%PATH%;c:\FBB\BIN 
  CD \BPQ 
  BPQCODE 
 

15 Reboot the computer. After the initial Windows 98 banner, the 
screen will go BLACK and display one line 
at the top of the monitor stating the 
BPQCODE is started.  Windows will 
continue to boot as usual.  BPQCODE is 
now loaded as a system program. 

FBB should be ready to run. 
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3.11 Initial Test 
16 Run the FBB Program as follows: 

START > 
  Programs >  
    FBB for Windows > 
      WinFBB 

The first time you run FBB, you will be 
prompted to create a bunch of system 
directories.  Accept all directory requests. 

17 Verify you can connect to FBB. 

From this 2nd PC, enter the following 
command: 

cmd:  connect kn6pe-5 

From another PC with packet capabilities, 
run a Terminal Emulator program.  Make 
sure that PC’s TNC is working correctly.   
 
A connect message is displayed and you 
should be connected to the FBB BBS. 
 

18 Send a message to yourself: 

BBS HELP> SP <your call sign> 

When prompted, enter a message title. 

When prompted, enter a message.  End the 
message. 

List messages to you… 

BBS HELP> LM 

Read the message… 

BBS HELP> R ### 

Exit the BBS 

BBS HELP> B 

 

This is the best simple test to see if all is 
working.  By sending a message to yourself, 
you can immediately list and read it back. 
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3.12 Update the BBS.SYS File 
Stations to which BBSs you forward (the callsigns after A in FORWARD.SYS) must also be in 
BBS.SYS.   In my case, there will be no forwarding.  Therefore, all call signs are removed. 

NOTE: There must be 80 (from 1 to 80) lines, even if you do not use them all.  The format is very 
critical, so do NOT change line-arrangement!  I have excluded a block of numbers.  This is an 
incomplete sample only.  See www.f6fbb.org/fbbdoc/fmtbbs.htm for details. 

 
########################## 
# BBS.SYS for FBB 7.00   # 
# for K6FB BBS by KN6PE  # 
########################## 
# 
# File containing all BBSs we forward to. 
# 
# Make sure that NO numbers are removed.  
# 
01 
02 
03 
04 
05 
06 
 : 
 : 
74 
75 
76 
77 
78 
79 
80 

3.13 Check the BEACON1.SYS File 
The following is an excerpt from www.f6fbb.org/fbbdoc/fmtbeaco.htm.  

This file makes the text that will be broadcast as mail-beacon from the BBS.  The first line is a 
parameter that says how often to send the beacon. %15 means "send one beacon every 15 
minutes".  The next line says to what unproto-address the beacon will be sent.  

 

This file is used as is.  No changes were applied. 
# %15 
! MAIL-1 
$d $T <<< Mailbox $O $c >>> $N active messages. 
Messages for$W$Q 
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3.14 Update the FORWARD.SYS File 
In my case, there will be no forwarding.  Therefore, the entire file is commented out.  This is a 
detailed configuration file.  I commended everything out.  See 
www.f6fbb.org/fbbdoc/fmtforwa.htm for details. 

**************** 
* Forward-file * 
*  for KN6PE   * 
**************** 
* 
* 
* HF 
* 
** < FWD\F6ABJ 
* 
* UHF/VHF 
* 
** < FWD\LA1B 
* 
* PMS 
* 
*< FWD\G0DJT 
*< FWD\LA6IM 
*< FWD\LA9RY 
*< FWD\LA4BL 
* 
* EXPORT 
* 
** < FWD\AMSAT 
* 
* Parking HF-rig 
* 
*P C 
*D QSY2 14.111 

3.15 Update the INITTNC1.SYS File 
The following is an excerpt from www.f6fbb.org/fbbdoc/finittnc.htm. 

When the BBS starts, it sends some standard parameters to the TNC, like PACLEN, 
MAXFRAME etc.  These parameters are in PORT.SYS.  But in addition to this, we may send 
some more parameters to each TNC.  We send parameters to TNC 1 with the INITTNC1.SYS, to 
TNC 2 with INITTNC2.SYS etc.  

The file used for this instance is per the BPQ file found at www.f6fbb.org/fbbdoc/fbpq.htm.  
# 
# INITTNC for BPQ interface 
# 
A1 
R0 
UMAIL 
M1 
N1 

3.16 Check the MAINT1.SYS File 
This file is used as is.  No changes were applied. 

UR1 
CTBBS ($c) was shut down for service $d $T. 
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3.17 Update the PASSWD.SYS File 
The following is an excerpt from www.f6fbb.org/fbbdoc/fmtpassw.htm. 

The first line in this file is the generic password.  That is, this password will be used for all sysops 
that do NOT have a special password of their own.   

The next line is a special password for one special sysop, in this case, KR6CO.  The two first 
numbers correspond to the same "security-numbers" in INIT.SRV (check this).  In this case, 
KR6CO will have the security- number 69 before a successful SYS-command, and 1023 after.  In 
the next line the numbers for K6TEN is 123 and 1023.  Each line in PASSWD.SYS can have a 
maximum of 255 characters.  

 
ThisisnotthepasswordfileIusebutishereasanexample 
KR6CO 69 1023 thisisthepasswordofkr6co 
K6TEN 123 1023 thisisthepasswordofk6ten 

3.18 Check the PROTECT.SYS File 
The following is an excerpt from www.f6fbb.org/fbbdoc/fmtprote.htm.  

This file allows you to specify some directories in which you do NOT want any sysop to be able to 
delete any files, without a special syntax.  To delete files in protected directories, the command 
must look like this: DEL +FORWARD.SYS.  In an un-protected directory the command looks like 
this: DEL FORWARD.SYS. So you can see that you need an extra '+' sign in protected 
directories.  

For my installation, I left this file in tact.  NOT DECIDED. 

 
\ 
\archiver 
\bbsfiles 
\bbsyapp 
\fastback 
\dos 
\fbb 
\fbb\files 
\fbb\mail 
\fbb\oldmail 
\fbb\sauve 
\fbb\yapp 
\ncsmall 
\norton 
\pascal 
\tools 
\yapp 

3.19 Other files not changed here 
For the general list of all the other files not covered here, check out… 
www.f6fbb.org/fbbdoc/docform.htm.  
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4 Final BBS Setup 

4.1 Introduction 
If you get this far, you are on your way to an operational BBS.  This section covers the following 
sections: 

User Setup 

Sysop Setup 

Configure PC to auto-boot the BBS after a power-fail 

4.2 User Setup 
For the DHS Packet BBS, the intent is to have all users pre-registered on the BBS prior to any 
disaster.  This is done as follows: 

 

1.  Identify the list of BBS users by call sign 
and tactical sign. 

This task will be left up to the ODMS 
communications staff. 

2.  JIM… see the screen to configure.  

4.3 Sysop Setup 
Volunteers for Sysop duty on the ODMS Packet BBS will be nominated and approved by the 
ODMS staff.  For each individual approved as a Sysop, specific training on remote access and 
system maintenance will be performed.  This is done as follows: 

 

3.  Identify the list of BBS Sysops.  These individuals must be approved by the 
ODMS staff.  

4.  The SYSOP password policy for this BBS 
is: 

1. Individual passwords will be developed 
for Sysop. 

2. Password file updates will be made by 
the ODMS communications lead. 

3. Passwords will be a combination of 
letters and numbers and should not 
spell a word. 

4. Passwords will be changed every 12 
months. 

 

5.  Edit and update the PASSWD.SYS file.  
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4.4 Auto-boot the PC after Power-fail – Windows 98 
The BBS PC may be located in a remote location and not readily available to an operator.  
Therefore, it is critical that the PC have the capability to boot up and run the FBB BBS without 
any operator intervention.   

Each version of Windows seems to set this up differently.  In general, the best recommendation is 
to search the Internet using the following string: 

“Prevent a Windows 98 Logon Prompt at Startup” or whatever version of windows you 
are using. 

For my Windows 98 System, I ended up at the Microsoft Support site 
(http://support.microsoft.com/default.aspx?scid=http://support.microsoft.com:80/support/kb/article
s/Q152/1/04.ASP&NoWebContent=1) and proceeded as follows: 

 

6.  Remove the Windows Network Logon. 

Click Start, point to Settings, click 
Control Panel, and then double-click 
Network. 

 

7.  On the Configuration tab, click Windows 
Logon in the Primary Network 
Logon box, and then click OK. 

 

8.  When you are prompted to restart your 
computer, click No. 

 

9.  In Control Panel, double-click Passwords.  

On the Change Passwords tab, click 
Change Windows Password, select 
any of the check boxes that you want, 
and then click OK. 

 

10.  In the Change Windows Password dialog 
box, type your current Windows 
password in the Old Password box.  
Leave the New Password and Confirm 
New Password boxes blank, click OK, 
and then click OK. 

 

11.  Reboot the PC.   Verify the PC does not prompt you for a 
logon password. 

12.  Make FBB automatically boot up. 

Navigate to the c:\FBB\BIN directory. 

Create a short-cut to WFBB.EXE 

Move the Shortcut to the Startup directory. 

 

13.  Reboot the PC. VERIFY the PC does the following: 
1. loads the BPQ software 
2. does not prompt for a logon and pass 
3. automatically loads the FBB BBS 

application 
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4.5 Auto-boot the PC after Power-fail – Windows XP 
For Windows XP System, Art N9ZZK found this reference 
(http://www.dougknox.com/xp/tips/xp_autologon_home.htm) on how to set this up: 

 

14.  Click Start, Run and enter  

CONTROL USERPASSWORDS2 

 

15.  In the list of users, highlight the user 
account you want automatically logged on. 

 

16.  Uncheck the box: 

“Users must enter a Username and 
password…”  

 

17.  Click Apply.  

18.  In the next dialog, enter the password for 
the account you selected in Step 2, if any 

 

19.  Press OK to complete.  

4.6 Periodic Shut-down/Auto-reboot of the PC  
Depending on your situation, your PC may require a periodic rebooting to address a problem 
where some other program (none described in this document) degrades the system performance 
over time.   

The following link points to a reboot utility that Art N9ZZK has used on his system to address a 
memory leak with another program he has running.: 

Reboot utility:  http://www.ampsoft.net/utilities/WinOFF.php 

 

 

<<< End of Implementation Guide. >>> 


